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Musition Features Overview

Musition contains 35 topics, covering areas such as Note Reading, Chords, Scales, , 
Rhythm, Instruments, Transposition, Terms and Intervals.  Each topic has a system 
of levels, allowing you and your students to work through Musition’s exercises in a 
progressive manner.

Musition includes many features that make using Musition in a classroom or network 
environment very easy.  We encourage you to use as many of these functions as possible.

Firstly, Musition enables you to track all your students results individually.  Numerous 
reports are built into Musition, so that you may print out student results as the need arises.

The Professor allows you to automate student progress.  The Professor will advise students 
when to move up and down through the levels, using settings that you control.  These 
settings are different for each class, allowing great flexibility.

As a practise tool, Musition excels, giving students a diverse selection of exercises to 
choose from.  The testing features give Musition a number of new applications.  Tests have 
a predefined list of quesitons for students to attempt.  All test results are stored separately 
and you may create as many tests as you desire.  Tests can be used for exams and quizzes 
or simply to customise Musition to your particular teaching method.

Musition 3.5 integrates with Auralia 3.5, allowing your students to have the same password 
and user name in both programs.  On a multi user network system this feature becomes 
even more valuable.
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Topics

Selecting a Topic

Musition contains five topic groups, identified by the five large panels across the bottom 
of your screen.  The topics within each group are listed under the group title.  To select a 
topic, click on the name of the topic.  You will then be shown a ‘Level Selection’ screen, 
where you will need to select a level.

Selecting a syllabus and level

Select the syllabus that you would like to practise from the box marked ‘Syllabus’.  The 
available levels for that syllabus will then appear in the ‘Level’ box.  Some syllabi will 
not have any levels in certain topics; this generally indicates that the particular topic isn’t 
represented in the syllabus.  There will always be levels in the ‘Auralia 3.5 / Musition 3.5’ 
syllabus, which is the syllabus provided by Rising Software.

As you click on a level, the accompanying description box will change to show the contents 
of the selected level.

All topics also have ‘Custom Levels’, where you can choose a selection of question types 
to be drilled on.  This feature is very useful when trying to eliminate a particular problem 
(eg. Minor 2nds and Major 2nds in the Intervals topic).  It is also possible to load and save 
custom levels in Musition 3.5, using the syllabus setup features.

Lesson Screens

All topics have an accompanying lessons screen.  Basic concepts regarding the topic are 
outlined, and examples are given.  For example, Chord Recognition Lessons shows you 
notated examples of chords and allows you to play the chords back.  To enter a lessons 
screen, click on the Lessons button when selecting a level. 

You may also enter a Lesssons screen by using the ‘Lessons’ menu from the main screen.

To Begin

To begin practising, click the ‘Start’ button on the level selection screen.  If you decide not 
to proceed with the topic, you can click on the exit button to leave the level selection or 
drill screen.

Using a Topic

When you have entered your answer, press OK.  If you are practising, Musition will tell 
you whether you were right or wrong.  If you were wrong, you may be able to try again.

Please consult the on line help system for more information regarding each topic.



Musition 3.5 User’s Guide    11

Options

Most options that you choose within the Administration screens in Musition apply 
regardless of whether record keeping is enabled or disabled.

If you don’t have record keeping enabled, Musition uses the ‘Default Class’ settings for 
certain program options (onscreen keyboard, question retries etc).

These options have to be changed on the Class Administration screen, for the Default Class.  
See the section on Class Administration later in this manual for further information.
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The Musition Screen

There are two toolbars in Musition, one that is active in the drills, and another which is 
active on the main screen.  Some functions are also accessed through the menu system.

Main Toolbar

Syllabus Selection

You can use the ‘Syllabus’ dropdown box to choose the syllabus that you’d like to practise.  
Once a syllabus has been chosen, only topics that are relevant for the syllabus will be 
shown.  If you would like to use all topics, simply choose the ‘Auralia 3.5 / Musition 3.5’ 
syllabus, which has a levels for each topic.

Starting a Test

If there are tests available for you to attempt, click on the button ‘Start Test’ on the main 
screen toolbar.  The Test Information box will indicate whether you have started or finished 
the test, if the resume function is available, the number of times you can take the test, and 
the number of times you have taken the test.

If the resume function is available, you may stop doing the test part of the way through, 
and then resume at the point where you left off the next time you use Musition.

NOTE: This function will only work if you are logged into Musition, and recording your 
results.

Checking your results

You can view your results by clicking on the button ‘Check My Results’ on the main screen 
toolbar.  This screen will give you immediate feedback on your progress in any of the 
topics.  You can choose to view the results for all syllabi, or a single syllabus.

You will be shown the number of questions that you have attempted in each level, and the 
percentage of these that you have answered correctly.  You may also select a ‘date range’, 
to narrow the time period from which your results are selected.  Simply click on the date 
boxes to select a starting and finishing date for the results you wish to view.

NOTE: This function will only work if you are logged into Musition, and recording your 
results.

The ‘File’ Menu

Changing your details

Click on the ‘File -> Change Your Details’ menu to change your details.  You will be able 
to change your password, class and voicetype by selecting the options provided  If you are 
changing your password, note that you will be required to type your new password twice.
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NOTE: This function will only work if you are logged into Musition, and recording your 
results.

Lesson Screens

Lesson screens relating to each topic can also be accessed using the ‘Lessons’ menu on the 
main screen.

Drill Toolbar

The toolbars that is active when using the drills gives you certain controls while practising 
and or testing.

Changing Levels

Depending on your current level, you can move either forward or back, one level at a time.  
The current level is displayed on the left hand side of the toolbar.

Scores

Your current score tally and percentage is shown in the middle of the toolbar.  This is reset 
each time you change level or topic.

Volume Control

The button on the far right of the toolbar will bring up the Windows mixer or volume 
control when clicked upon.  This will allow you to change volume settings without leaving 
Musition.

Tempo

The tempo bar on the allows you to change the tempo of the current example.  For instance, 
if you were doing a rhythmic dictation exercise, and it was a little too fast, you could slow 
it down by using the slide bar.  The metronome marking is indicated on the left hand side of 
the toolbar, and the note shows the beat value.
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MIDI Sound

Introduction

The MIDI setup screen allows you to control the way Musition uses MIDI in your system.  
From the main menu, select ‘Administration -> Sound and Pictures -> MIDI sound’ to open 
the MIDI setup screen.

You can have a MIDI output device set within Musition, or use the default device that is 
selected within Windows.

MIDI Output Device

Choose your MIDI Output device from those listed.  Click on the ‘Test MIDI Playback’ 
button to test the device.

If you are running Windows Vista, this is the best way to choose your MIDI output device.

MIDI Output Device set in the Multimedia Control Panel

If you choose this option, Musition will use the output device that is selected in the 
Multimedia Control Panel.  To choose your MIDI output device, click the button ‘Open the 
Multimedia Control Panel’.  Follow the instructions below, depending on your version of 
Windows.

Windows 95/98/NT

- Click on the MIDI tab.

- Check that the correct instrument is selected under ‘Single Instrument’.

Windows ME, 2000 or XP

- Click on the Audio tab.

- Check that the correct instrument is selected under ‘MIDI Music Playback’ -> 
‘Default Device’.

Regardless of the version of Windows, you will probably have a number of different 
instruments available.  Instruments with descriptions such as ‘MIDI Output’, ‘MPU-401’, 
‘MIDI UART’ or ‘External MIDI Device’ are typically only used if you have an external 
keyboard or sound module.

We recommend avoiding wavetable synthesis devices if possible, as their rhythmical 
accuracy is often poor.

Note that in Windows Vista, it is quite difficult to select your default Windows MIDI 
Output device.  We recommend choosing it directly in Musition, as described above.
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General MIDI Reset

By default, Musition plays a General MIDI Reset upon startup, to ensure that you hear the 
correct question sounds.  Depending on your MIDI configuration, this may cause problems.  
Uncheck this box if you wish to disable this feature.

Latency Setting

Check this option if you are using a software synthesizer that is not responding quickly 
enough when using topics such as Rhythm Imitation. Instead of using MIDI sounds to play 
your taps, wave sounds will be used.

If you select this option, please check the balance between your MIDI (or synthesizer) 
sound and Wave sound output in your Windows mixer. 

MIDI Input

If you have an external MIDI device, such as a MIDI Keyboard or MIDI Wind Controller, 
you can use this for input in certain topics.  Ensure that the box marked ‘Enable MIDI 
input’ is checked, and choose your input device from the drop down box.

If your device is working, and Musition is receiving the MIDI notes, you will see the 
‘MIDI Input Indicator’ flash as you play notes.

MIDI Through

If you have a MIDI Input enabled, you can also choose to have notes from your MIDI Input 
device passed through to the MIDI ouput device.  Depending on your MIDI configuration, 
you may need to select this to ensure that you hear notes when they are played on your 
external MIDI device.

MIDI Volume Levels

You may wish to change the balance of volume between MIDI sound (questions) and Wave 
sound (‘correct’ and ‘incorrect’ sounds).

- Click on the small speaker icon located on the Musition toolbar. This will load the 
Windows volume control.

- Adjust the sliders for the ‘Wave’ device and ‘MIDI’ / ‘Synthesizer’ device.

- If these devices are not available, click on the ‘Options -> Properties’ menu.  From 
this screen, you should be able to enable the devices you require using the list of 
available volume controls.  Click on OK.

- Close the mixer and test the new levels in Musition.

To make further adjustments, repeat the above steps.
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MIDI Emphasis

All rhythm topics have an emphasis played on the major beats of each bar.  You can 
increase or decrease the amount of emphasis on these beats by moving the slide bar with 
the mouse.  You can also make the metronome louder or softer.

Use the ‘Test’ button to hear an example of rhythm played with the metronome.

Similarly you can increase the emphasis on the bass line in chord progression and cadences 
topics, by moving the chords slide bar. The test button will play an example cadence with 
the emphasis you have chosen.

You can also change the amount of emphasis played on the major beats during a melody.  
Increase or decrease the amount of emphasis on these beats by moving the slide bar with 
the mouse.
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Wave Sound and Pictures

Correct and Incorrect Sounds

Wave sounds can be played at certain times during a session. However, these sounds are 
only possible if you have sound hardware capable of wave form audio (e.g. SoundBlaster, 
SoundMax etc). If you are using pure MIDI equipment, it is unlikely that these features 
will work. 

To open the wave sound setup screen, select ‘Administration -> Sound and Pictures -> 
Wave sound’.

Play Startup Sound

If this option is selected, a sound will play when Musition is loaded.  This sound cannot be 
changed.

Play Closing Sound

If this option is selected, a sound will play when Musition is closed.  This sound cannot be 
changed.

Play sounds for a correct answer

If this option is selected, when a student gets a question correct a correct sound will be 
played.  The sound will change each time, chosen randomly from a selection.

Play sounds for an incorrect answer

If this option is selected, when a student gets a question incorrect an incorrect sound will be 
played.  The sound will change each time, chosen randomly from a selection.

Pictures

When you submit an answer, the screen that informs you whether you answered the 
question correctly or incorrectly also has a picture showing.

You can choose to have a simple tick or cross, or have a picture chosen randomly from the 
full selection.  The full selection contains cartoon type pictures, and may be considered 
suitable for younger students.



18    Rising Software

Security and Record Keeping

Musition is capable of recording all results, allowing you to track individual student 
progress.  Results can be printed out, and you may also reset each student’s scores when 
necessary.

Quick Start

If you want to get started quickly with the record keeping features, follow these steps!

1) Enter your administrators and teachers into the program - use the ‘Administration -> 
Users -> Maintenance’ screen.  You must have at least one administrator to use the 
record keeping features.

2) Enter your classes into the program using the ‘Administration -> Classes -> 
Maintenance’ screen.  You may not need to add any extra classes - Musition will always 
have the Default Class available.

3) Create tests for your classes using the ‘Administration -> Tests -> Maintenance’ screen.  
You may not wish to setup tests at this stage; this can be done at a later date.

4) Enable the security and record keeping system.  Use the ‘Administration -> Security and 
Record Keeping’ screen.  Turn the option ‘Use Names and Password’ on.

5) Let students use the software!  At this stage, when a student uses Musition, they will be 
prompted for a name and password. 
 
The first time a student uses Musition, the student will be taken to an auto registration 
screen where they enter their name, choose a password, a class and a voice type.  At a 
later stage, you can view and edit all the enrolled students using the ‘Administration -> 
Users -> Maintenance’ screen. 
 
Students who use the auto registration screen are given student level access only. 
 
If you have created a test for the class in which a student is in, a message will inform 
them that a test is available when they first start the program.

6) You can now view your students results using the various reports on the ‘Administration 
-> Reports -> Practise Results’ screen.

What is a User

If you wish to record your students’ progress, they will each need to be ‘enrolled’ into 
Musition and given a login name and password.  Each student will also need to belong to a 
class.  See the section ‘User Administration’ for further details.
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What is a Class

A class is simply a grouping of students.  They are very much like the classes found in a 
typical school environment  If you are using Musition in a school, we recommend that you 
simply replicate your existing school class structure within Musition.

As a private teacher, you may wish to setup your own class structure to group your 
students.  Musition has a built in class, called the ‘Default Class’, which you can add your 
students to if you wish.

There are particular options that you can set for each class, giving you the flexibility to 
tailor Musition for different groups of students.  See the section ‘Class Administration’ for 
further details.
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Security

Musition has a security and record keeping system which when enabled provides users 
with different levels of access to the program.  This screen allows you to set the security 
level that you wish to use and thereby define whether students, teachers and administrators 
will be asked for their password upon entering the software, and whether their scores will 
be recorded.

To open the security and record keeping setup screen, select ‘Administration -> Security 
and Record Keeping’.

The most secure option, and the option that is highly recommended when more than one 
person is using the software, is ‘Logins Enabled - Use names and passwords’.  This allows 
record keeping for multiple users.

To make one of the security settings active, simply click on the button next to it, and set the 
relevant options as described below.

No security 

You and your students will not be required to enter a name or a password to enter the 
program, or to enter this administration section.  No statistics will be recorded, and 
anybody who uses the program will be able to access all parts of the administration.

Password protection for administration functions 

You will not be required to enter a name or password to enter the program, but you will 
be prompted for a password when entering any administration screen.  You are required to 
type in an administration password in the box labelled ‘Administration Password’.

Automatic login of a Single User 

You will not be required to login, but your statistics will be recorded under the username 
selected from the list (you must have setup a user).  You are required to type in the users 
password on this screen. Regardless of the security level that the user has (Student, Teacher 
or Administrator), when using this feature, Administrator access is granted. 

All other settings that the user has (class, voicetype etc) will be used, allowing tests to be 
taken, and singing topics to be used correctly.

Logins Enabled - Use names and passwords 

This is the most secure and flexable setting.  The software will use a name and password to 
identify individual users, record statistics under their name, and uses their access level to 
grant permission to various parts of the program.  When the program is started, all users are 
asked for their name and password.

Before you can enable this option, you must add an ‘Administrator’ user to the system, 
which is explained in the following section ‘User Administration’.
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Users

The user maintenance screen (‘Administration -> Users -> Maintenance’) allows you to 
add new users to your configuration, and change details of existing users, such as their 
passwords. For each student or administrator using the software, their name, password, 
class, voice type, and an access level is recorded.

By default, ALL the users enrolled are shown.  By clicking on the box labelled ‘Show only 
Users in class’, you may filter the list to show a single class of users. Simply select the 
class of users that you wish to view from the dropdown box.  The user maintenance screen 
allows you to add new users to your Musition configuration and change details of existing 
users, such as their passwords.

User Administration

Access Levels

An access level sets the functions that any particular user may perform within the software.  
There are three levels of access.  Student access is the most common; it allows people to 
use the program, but does not allow any administration or configuration of the system.  
Teacher access allows access to statistics, but not to configuration, class, user or test 
maintenance.  Administrator access allows all of these functions. 

NOTE: Both Teacher and Administrator access levels DO allow use of the drills, as well as 
access to the various administration screens.

Adding a New User

To add a new user, click the “New User” button.  Enter the user’s name in the User Name 
column, and then set a password in the Password column.  In the Class column, select 
which class the user belongs to.

If this user is a teacher or an administrator, select their level of access from the options 
provided.  You must have a user with administrator access if using names and passwords 
in Musition.  If such a user does not exist, you will not be able to use the configuration and 
administration functions on the Administration menu.  You will then be LOCKED OUT of 
the program.  If this happens, contact Rising Software for further assistance.

Finally, choose the user’s voice type (soprano, alto, tenor or bass) and whether the user 
should get feedback when they get an answer correct.

When you are finished, press the Enter key.  Your new user will then be ready.  If you don’t 
want to save your new user, press the Escape key.

Editing an existing user 

Locate the user in the user list box, click on him/her, then click on the item you wish to 
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change and make your changes.  (See Adding a new user, above).  Your changes will then 
be saved automatically.  If you don’t want to save your changes, press the Escape key on 
your keyboard.

Deleting a user 

Select the user in the user listing (by clicking on him or her), then click “Delete User”.  The 
user will then be removed from the system. You cannot remove yourself from the system.

Clearing Results

The box ‘Clear Results for this User’ allows you to delete practise and test results for the 
selected user.  You can also delete the results for a single test that the user has attempted.

If you wish to clear all the results, use the buttons in the box ‘Clear Results for ALL Users’.

Restricting the List of Users

By default, ALL the users enrolled are shown.  By clicking on the box labelled ‘Show only 
Users in class’, you may filter the list to show a single class of users.  Simply select the 
class of users that you wish to view from the dropdown box.

Importing Users

If you already have a list of users, you can import them by clicking the ‘Import Students’ 
button.  Your user names need to be in a comma separated text file.  The format is shown on 
screen after you click the button.

User Options

There are various options that can be set for users on the ‘Administration -> Users -> 
Options’ screen.

Automatic User Registration

If enabled, new users can automatically enrol themselves into the program database.  
(If this option is disabled, an administrator must add each user individually using User 
Maintenance)  If a user enrols themselves, they are automatically given Student access, and 
thus will not have access to teacher or administrator functions.  It is recommended that you 
enable this option in a school environment to avoid adding each user individually to your 
system. 

Note: This option only takes effect if the security setting ‘Logins Enabled - Use Names and 
Password’ is selected.

Allowing Users to Change their Settings

If this option is enabled, users can change their own password, class and voice type. If this 
is disabled, the user will not be allowed to change these details.
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Note: This option only takes effect if the security setting ‘Logins Enabled - Use Names and 
Password’ is selected.

If this option is enabled, Musition will allow people using the program to change their 
password, class and voice type.  If this is disabled, the user will not be allowed to change 
these details. 
 
NOTE: If Musition is does not have ‘Use names and passwords’ enabled (see Security & 
Logging In), this option will have no effect.

Single User Settings

This screen (‘Administration -> Users -> Single User Settings’) provides options for when 
the software is being run in a single user environment.  (ie. not on a network with multiple 
users)  The settings on this page will only take effect if you are using the security option 
‘No security’.

Voice Type 

If you are using the software in this environment then you may select your voice from the 
drop-down box provided.  This will ensure that you receive singing / microphone questions 
in the correct vocal range.

Show message for correct answers 

This setting allows you to move on to the next question immediately, if you get the question 
correct.
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Class Administration

The class maintenance screen (‘Administration -> Classes -> Maintenance’) allows you to 
add classes to your configuration. You can also edit the settings of existing classes. For each 
class, the name of the class, it’s teacher, it’s default syllabus, and a number of other settings 
are stored.

Class Administration

Adding a New Class

To add a new class, click on the “New Class” button. You will then be able to enter the 
name and teacher of the new class, and set the options. Click on the ‘Class Name’ column 
and enter the name of the class.

Syllabus

Choose the default syllabus that the class will use in the ‘Syllabus’ column. You can allow 
students to change the syllabus that they are using during practise by clicking the box in the 
column ‘Allow students to change Syllabus’.

Retry Questions

Students may retry questions which they answer incorrectly whilst practising if the box 
‘Allow Students to Retry Questions’ is ticked.

Professor

If this option is enabled, users will be advised to move up and down levels based on 
thresholds that you setup on the Professor setup screen.

Teacher

Select the name of the teacher for this class. This is the name that will appear when you 
print out reports for this class.

Enable Metronome

Checking this box allows the metronome to be used in topics such as Rhythm Dictation and 
Melodic Dictation.

Allow students to disable Metronome

If the metronome is enabled, and you turn this option on, students can enable or disable the 
metronome while they are practising the relevant topics.

Use the onscreen keyboard

Auralia features an onscreen keyboard, which can be used to enter the answer in certain 
topics.  Enable or disable this option as required.  This option is not relevant in Musition.
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Use external MIDI keyboard

If you have an external midi keyboard and wish to use it for answer input, select this 
option.  External MIDI input is only supported in certain topics.

Use onscreen guitar

Auralia features an onscreen guitar, which can be used to enter the answer in certain topics.  
Enable or disable this option as required.  This option is not relevant in Musition.

Editing an existin g class 

Locate the class in the class listing, click on it, then make your changes (see “Adding a new 
class”, above). Your changes will be saved automatically. If you don’t want to save your 
changes, press Escape key.

Deleting a class 

Select the class from the list, then click ‘Delete Class’. Note that if you delete a class, all 
users in that class will be reassigned to the ‘Default Class’.

Copying a class

You can create a copy of a class by clicking the ‘Copy Class’ button. All class settings are 
copied. The new copied class will not contain any students or results.

Clearing Results

The box ‘Clear Results for this Class’ allows you to delete practise and test results for the 
users within the selected class.

Minimum Levels and Topic Settings

This screen (‘Administration -> Classes -> Minimum Levels’) allows you to set options for 
topic, and minimum levels for each class.  By setting a minimum level for a class, you stop 
students from practising any level lower than the level you have set.

Topics

You can choose to turn certain topics off for each class.  This allows you to disable topics 
that aren’t appropriate for the class, or to channel your students into areas that you feel 
need more practise.  To disable a topic, select it from the box marked ‘Topic’, and uncheck 
the box marked ‘Active Topic’.  To enable the topic, ensure that the box is checked.

You can also change the number of times users in the class can retry each question. Select 
the number of retries from the ‘Retries allowed’ box.

Neither of these settings affect tests.
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Minimum Levels

Minimum levels are setup on a syllabus basis.  A general ‘Level 4’ setting isn’t possible, 
as some syllabi may have six levels in a particular topic, while others may have a different 
number of levels, some fewer and some greater.

To select a minimum level, select your topic from the ‘Topic Box’ and the syllabus you 
would like to set them for from the ‘Syllabus’ box.  The box marked ‘Minimum Level’ will 
then show you the levels that exist for that particular topic and syllabus.

Select your minimum level from the box marked ‘Minimum Level’.

The Professor

When students are practicing, and achieving a high percentage of correct answers, the 
program will suggest that they move to the next level.  Similarly, if they are achieving a low 
percentage, the program will suggest that they move to a lower level.  This screen allows 
you to set the percentages needed to move to a higher or lower level.

Select a class from the box marked ‘Class’.  If the box marked ‘Allow users to ignore 
professor ‘ is checked, when the professor makes a suggestion, students may click “No 
thanks” to ignore the advice.  If this option is disabled, students MUST change level when 
the professor suggests it.

You must now choose whether to have the same settings for all topics, or individual settings 
per topic.

Same Settings

Click on the button marked ‘Use the SAME settings for all topics’. 

Enter the percentage of questions the user must exceed for the professor to suggest moving 
to the next level.  You may also enter the percentage to move to the previous level; when 
students score lower than this percentage, the professor will suggest they move to the 
previous level.

Finally, you may choose how many questions students must answer before the professor 
will give them any advice.

Individual Settings

Click on the button marked ‘Use INDIVIDUAL settings for all topics’ and select the topic 
you wish to change from the drop-down list.

Enter the percentage of questions the user must exceed for the professor to suggest moving 
to the next level.  You may also enter the percentage to move to the previous level; when 
students score lower than this percentage, the professor will suggest they move to the 
previous level.

Finally, you may choose how many questions students must answer before the professor 
will give them any advice.
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Syllabus Setup

In Musition, a syllabus is a group of levels.  Generally, a syllabus will have levels in each 
topic, but it is possible for a syllabus to not have any levels in a particular topic.

Syllabi make it possible to tailor the content of Musition to suit varying age groups 
and ability levels.  They also allow the content within Musition to be used for varying 
examination standards around the world.

Note that you cannot modify any of the syllabuses that are included with the software.  If 
you wish to change the settings or levels of one of the provided syllabuses, make a copy of 
the syllabus.  The copied syllabus will be able to be modified.  You can then set the copied 
syllabus as your default in the Class Administration.

Syllabus Administration

The syllabus administration screen (‘Administration -> Syllabus and Levels -> Syllabus 
Setup’) allows you to add and delete syllabi from your configuration.

Adding a new syllabus

To add a new syllabus, click on the ‘New Syllabus’ button.  You will then be able to enter 
the name of the syllabus.  There are a number of options for each syllabus.

Country

Select the country from which the syllabus originates.

Rhythm Terminology

Choose between US (half, quarter notes etc) and UK (minims, crotchets etc) style 
terminolgy.  You can choose both, in which case, when relevant, both styles will be used - 
Musition will randomly choose between them before each question.

Note that this option does not change the terminolgy shown on the level selection screens, 
that is handled under ‘Language and Terminology’.

Description

Enter a description of the syllabus.  This will appear on level selection screens when the 
syllabus is chosen.

Instrument Choice

You can choose between a single instrument sound or random instrument sounds for your 
questions.  The random sounds have been chosen to ensure that in a drill context, each 
sound will allow the student to clearly hear;

- the duration of the note

- the pitch of the note without any strong overtones
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Instrument Sounds

When you are selecting a single MIDI instrument sound for all questions, please consider 
the following points;

- when held for longer note values, will the sound clearly represent the duration of the 
note?  For example, a clean guitar sound will have an attack, and then the note will fade 
making the duration of the note less obvious, whereas a flute sound will be held clearly for 
the full duration of the note.

- does the sound have strong overtones that may make the pitch of the note more difficult to 
hear?  For example, some MIDI organ sounds have very strong octave or fifth overtones

Metronome Sounds 

Choose the drum sound for the start of a bar, and the sound for a regular beat.

Deleting a syllabus 

Select the syllabus from the list, then click ‘Delete Syllabus’.  

Note: All the levels and results for that syllabus will also be deleted.

Copying a syllabus

It can be useful to make copies of a syllabus.  For example, you may create a syllabus for 
one group of students and then want to modify it slightly to suit another group.

Select the syllabus from the list, then click ‘Copy Syllabus’.  The copy of the syllabus will 
appear in the list of syllabi.

Exporting a Syllabus

You can export a syllabus by clicking on the ‘Export Syllabus’ button. The syllabus will 
be outputted to a file of your choosing, which can then be imported by others who use 
the software. Any customsied content (Chord, Scales etc) that is not provided by Rising 
Software will also be exported. For example, if you customise one of the chords or scales 
that is provided by Rising Software, those changes WILL NOT be exported. However, if 
you added a new chord or scale and used that in your syllabus, then the new chord or scale 
WILL be exported.

Note that if you are not running the same version of the software as the person who is 
going to import the syllabus then you will have problems. Ensure that you are running the 
latest version by checking at http://www.risingsoftware.com/.

Importing a Syllabus

Click on the ‘Import Syllabus’ button to import a syllabus. You will need to choose the file. 
Note that customised content may also be imported (Chords, Scales etc).

Note that if you are not running the same version of the software as the person who created 
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the test then you will have problems. Ensure that you are running the latest version by 
checking at http://www.risingsoftware.com/.

Syllabus Levels

Levels are added to a syllabus one topic at a time.  Enter the Syllabus Administration 
(‘Administration -> Syllabus and Levels -> Syllabus Setup’) screen, and click on the 
‘Syllabus Levels’ tab.  

Select your syllabus and topic from the dropdown boxes.  The levels for the syllabus and 
topic will appear in the ‘Topic Levels’ box.

Adding a level

To add a level for the syllabus and topic, simply click on the ‘New Level’ button.  There are 
a number of options for each level 

Test Only: 

Select this if you do not wish to have the level available for general practise use.

Description: 

Enter a description of the level .  This will appear on level selection screens when the level 
is chosen.

Copying a level

Click on the ‘Copy Level’ button to make a copy of a level.  This can be useful when 
creating levels that have cumulative content.

Editing the level

The level has now been created, but it has no content.  It will appear in level selection 
screens, but you will not be able to use it.  You need to add content to the level - click on 
the ‘Edit Level’ button.

The level editing screen for the topic will open up, and you are free to define the content 
of the level as you wish.  Click on ‘Ok’ when you are finished.  Refer to each topics help 
screen for further details regarding the various options contained in each topic.

Deleting a level

Select the level from the list, then click ‘Delete Level’.  Note: All the results for that level 
will also be deleted.

Level Order

Use the ‘Move level up’ and ‘Move level down’ buttons to change the order of the levels.
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Tests

A test is a sequence of questions taken from various levels of various topics.  When 
you create a test, you choose which topics will be tested, which levels in those topics, 
and how many questions will be asked from each.  You also control the order in which 
the topics are tested.

When students log in, they will be informed if there any tests available for their class.  
They can start a test by going to the File menu and selecting Start Test.  You can view 
students’ test results in the Administration menu under Reports.

Note that tests can only be taken if you have logged into Musition - see the previous 
section ‘Security’.

Test Administration

The test administration screen (‘Administration -> Tests -> Maintenance’) allows you 
to add and delete tests from your configuration.  For each test, you must specify a test 
name and set a number of options.

Adding a new Test

To add a new test, click on the “New Test” button.  You will then be able to enter 
the name of the test in the grid, under the column marked ‘Test Name’.  There are a 
number of options available for each test:

Correct Incorrect Feedback

When doing a test, the facility for students to be told whether they answered the 
question correctly or incorrectly can be disabled.

Allow test resumption

If this option is enabled, students will be able to stop in the middle of a test, and 
resume the test from where they left off at a later date.

Allow tempo changes

The tempo bar is active in most topics, allowing students to speed up or slow down the 
examples. The can be disabled this in a test if you wish.

Number of test attempts

If you are wanting students to take a test multiple times, instead of resetting students 
results, you can simply allow a higher number of test attempts.  This will allow you to 
compare the results from each attempt.

Tests have to be assigned to various classes, listed under the ‘Classes’ box.  If you 
would like students in a particular class to be able to take a test, select the class in the 
‘Classes’ box.  You can select multiple classes.
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Deleting a test 

Select the test from the list, then press the “Delete Test” button. 

NOTE: Any results that were available for the test will be lost.

Copying a test

Click on the ‘Copy Test’ button to create an exact copy of a test. Results are not copied.

Exporting a Test

You can export a test by clicking on the ‘Export Test’ button. The test will be outputted to 
a file of your choosing, which can then be imported by others who use the software. If the 
test that you are exporting contains a customised syllabus then that syllabus will also be 
exported.

Note that if you are not running the same version of the software as the person who is 
going to import the test then you will have problems. Ensure that you are running the latest 
version by checking at http://www.risingsoftware.com/.

Importing a Test

Click on the ‘Import Test’ button to import a test. You will need to choose the file. Note 
that syllabi may also be imported, if the test that you are importing contains a customised 
syllabus.

Note that if you are not running the same version of the software as the person who created 
the test then you will have problems. Ensure that you are running the latest version by 
checking at http://www.risingsoftware.com/.

Clear results 

To reset all the results for a test, select it from the list and press the “Clear Results” button.
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Content and Topic Customisation

Language

Choose the language that you would like to use on the language screen (‘Administration 
-> Language and Terminology -> Language’) from the options shown. It is highly 
recommended that you restart the program after changing language, to ensure that all text is 
translated properly.

Terminology

You can change the way certain musical items are described on the Terminology setup 
screen (‘Administration -> Language and Terminology -> Terminology’).

The settings on this screen are general settings only, and apply to level selection screens. 
They do NOT change the type of termonlogy that you see in the drills. If you wish 
to change the terminology within the drills, you must change the terminology for the 
particular syllabus.

Notes

If you wish to use British terminology instead of American terminolgy check the box 
marked ‘Use the term “crotchet” instead of “quarter note” etc’.  This will apply throughout 
the program.

Chord Progressions

Choose between Figured Bass (I, I6, I64) or Letters (I, Ib, Ic) etc.

Scale Degrees

You can have scale degrees shown as ‘Tonic, Dominant’, ‘First, Fifth’ or ‘1, 5’.

Chord Editor

The chord editor (‘Administration -> Topics -> Chords’) allows you to add new chords to 
Musition.  These chords can be used in the Chord Recognition, Chord Singing, Jazz Chords 
and Jazz Chord Singing topics.

Adding New Chords

If you wish to add a chord, click on the ‘New Chord’ button.  You then need to enter a name 
for your chord, and click in the notes of the chord, on the staff marked ‘Chord’. You may 
also wish to enter a ‘Voiced’ version of the chord, for use in topics such as Jazz Chords.

As you enter the chord, you can hear either version of the chord by using the ‘Play this 
chord’ buttons.

If you wish the chord to be available in the Chord Recognition topic, ensure that the box 
marked ‘Use in Chord Recognition’ is checked.
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Deleting Chords

To delete a chord, click on the ‘Delete Chord’ button. Certain chords cannot be deleted.

Use in Chord Recognition Option

Please note that the voiced versions of the chords are only used in the Jazz Chords topic, 
whilst the stacked versions are used for other chord topics.  Check the ‘Use in Chord 
Recognition’ box if you wish this chord to be used in the chord recognition topic.  There 
are some chords which you may not wish to be included in this topic as the chord symbol 
may not clearly describe all the implied notes that would occur in a stacked version of the 
chord.  One example of this is a 7#9 chord, which when played or viewed as a stacked 
chord would include additional altered notes that the chord symbol does not define.

NOTE: To ensure correct transposition of your chords, ensure that you enter them 
using ‘C’ as the tonic note.  For example, if you are entering a Major 1st Inversion 
chord, the root note would be E above C.

Chord Scale Relations Editor

This screen allows you to edit the chord scale relations that appear in the Chord Scale 
Relations topic, and add new relations if you wish.

Adding Chord Scale Relations

Available Chords: A complete list of the available chords is shown in this box. To choose 
chords, you need to move them to the box marked ‘Included Chords’. You can do this by 
double clicking on the chord you’d like to use, or by selecting the chord (single click) and 
clicking on the ‘Hand’ that is pointing to the ‘Included Chords’ box.

Included Chords: This box lists the chords that you have chosen to practise. To remove 
chords, you need to move them back to the box marked ‘Available Chords’. You can do this 
by double clicking on the chords you’d like to remove, or by selecting the chord (single 
click) and clicking on the ‘Hand that is pointing to the ‘Available Chords’ box.

Once a chord is in the ‘Included Chords’ box, you can begin to associate scales with the 
chord. Simply select the chord in the ‘Included Chords’ box, and then click on each scale in 
the ‘Associated Scales’ box. A chord can have more than one associated scale. 

Deleting Chord Scale Relations

Move the chord out of the ‘Included Chords’ box into the ‘Available Chords’ box.

Concepts Editor

This screen (‘Administration -> Topics -> Concepts’) allows you to edit concepts that 
appear in the program, and add new concepts if you wish. You can then add these concepts 
to levels in the various Concept topic.
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Adding Concepts

If you wish to add a concept, click on the ‘Insert Concept’ button and enter a name for your 
concept in the box marked ‘Concept Question’. 

You then you need to provide eight different answers or definitions of the concept and type 
them in the spaces provided. You need to give each of these answers a rating between 1 
and 4. A rating of 1 indicates the correct answer, a rating of 2 indicates a plausible answer, 
a rating of 3 indicates a less plausible answer and a rating of 4 indicates an outrageous or 
irrelevant answer. There must be only one answer with a rating of 1!

Deleting Concepts

To delete a concept, click on the ‘Delete Concept’ button.

Scale Editor

The scale editor (‘Administration -> Topics -> Scales’) allows you to add new scales to 
Musition.  These scales can be used in the Scales, Scale Singing, Jazz Scales and Jazz Scale 
Singing topics.

Adding New Scales

If you wish to add a scale, click on the ‘New Scale’ button.  You then need to enter a name 
for your scale, and click in the notes of the scale, on the staff marked ‘Scale’.  As you enter 
the scale, you can hear it by clicking the ‘Play this scale’ button.

Deleting Scales

To delete a scale, click on the ‘Delete Scale’ button.  Certain scales cannot be deleted.

NOTE: To ensure correct transposition of your scales, ensure that you enter them as if 
they had a key signature with no sharps or flats.

Terms Editor

This screen allows you to edit terms that appear in the program, and add new terms if you 

wish. You can then add these terms to levels in the Terms topic.

Adding Terms 

If you wish to add a term, click on the ‘Insert Term’ button and enter a name for your 

concept in the box marked ‘Term Question’.

You then you need to provide eight different answers or definitions of the term and type 
them in the spaces provided. You need to give each of these answers a rating between 1 
and 4. A rating of 1 indicates the correct answer, a rating of 2 indicates a plausible answer, 
a rating of 3 indicates a less plausible answer and a rating of 4 indicates an outrageous or 
irrelevant answer. There must be only one answer with a rating of 1!
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You also need to choose the original language of the term, and the category that the term 

fits into. 

Deleting Terms 

To delete a term, click on the ‘Delete Term’ button. Certain terms cannot be deleted.
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Results and Reports

The reports screen allows you to find out information on all of the program’s users and 
observe your students’ progress in both tests and practice.  Musition can only record 
statistics and track users and classes if the ‘Use Names and Passwords’ security option is 
being used.

All of the report screens can be found under the menu ‘Administration -> Reports’.

Detailed information regarding operation of each topic drill can be found in the online 
Help.

Lists and Settings Reports

These reports allow you to see lists of your users, classes, tests and syllabi. You can also 
see things such as class minimum levels and settings. Select the report type from the box 
marked ‘Report type’, and pick your options from the ‘Report Options’ box. Click on the 
‘Preview Report’ button to view and print the report.

User Details 

This report will show you lists of your currently enrolled users. You can choose to view all 
of your users, or only those in a certain class.

Class Settings 

This report will show a list of your classes, showing the various options that are set for 
each.

Class Minimum Levels 

This report will show you any minimum levels that have been set for your classes.

Test Details 

This report will list your tests, showing what classes they apply to, and the various settings. 

Test Entries 

This report will list all the entries within your test, showing the details of each entry.

Syllabus 

This report will list your syllabi, showing the settings that each syllabus has. You can also 
choose to display all the levels within the syllabus. 

Practise Results Reports

These reports allow you to see the practise results for each user. Select the report type from 
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the box marked ‘Report type’, and pick your options from the ‘Report Options’ box. Click 
on the ‘Preview Report’ button to view and print the report.

User Results - Overall Score 

This report combines the scores fom all the topics in all Syllabi, giving an overall grade.

User Results - Overall Score by Syllabus 

This report shows your combined users results from each syllabus, combining all topics for 
that syllabus. 

User Results - Overall Score by Topic 

This report shows your combined users results for each topic. The results for each syllabus 
and it’s set of levels are combined.

User Results - Detailed 

This report will show your users results, for each syllabus, and each topic within that 
syllabus. It is the most detailed report that is available for users results.

Test Results and Status Reports

This screen allows you to view test results and status. Select the report type from the box 
marked ‘Report type’, and pick your options from the ‘Report Options’ box. Click on the 
‘Preview Report’ button to view and print the report.

Test Results 

This report shows your test results. You can choose to be shown an overall score, or the 
score for each entry.

Test Status 

This report shows which students in a class have taken the test, and how many times they 
have attempted it.

Report Options

This screen allows you to select your preferred paper size. Select from either ‘A4’ or 
‘Letter’ - this option is stored for later sessions.
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Topic Descriptions

This section gives you a brief description of each topic.  The level structures for each 
syllabus can be viewed within Musition, using the reporting functions.

Advanced Note Reading

In Advanced Note Reading, you will have to identify notes on a staff, or click in notes on a 
staff.  Alto and Tenor clef are used.

Beaming

In Beaming, a rhythm without beams is shown on screen, and you are asked to put the 
correct beams in using the mouse.

Chords

In Chords, you will have to identify a chord that is shown on a staff, or click in a chord on 
a staff.

Chord Scale Relationships

Chord Scale Relations tests the ability to relate chords and scales, in a jazz context.

Clef Transposition

In Clef Transposition, you will have to be able transpose short melodies from one clef to 
another.

Concepts

Concepts tests the knowledge of common music concepts, the fundamentals of written 
vocabulary. Questions are multiple choice.

Diatonic Chords

In Diatonic Chords, you will have to identify a chord that is shown on a staff, or click in 
a chord on a staff. The chords will based on the scale degrees of the Major and Harmonic 
Minor scales.

Drum Sticking

In Drum Sticking, you will tap back a rhythmic pattern with your left and right hands.
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Drum Styles

In Drum Styles you will tap back a rhythmic pattern which is shown on screen. The pattern 
is one part (eg: Snare Drum part) of a rhythmic style that would commonly be played on a 
drum kit.

Enharmonic Notes

In Enharmonic Notes, you will have to be able to identify enharmonic variations of notes.

Guitar Symbols

In Guitar Symbols, you will have to identify the chord that is represented by the guitar 
symbol.

Instrument Keys

In Instrument Keys, you are asked to identify the keys of various instruments, and identify 
the most ‘common’ key.

Instrument Knowledge

Instrument Knowledge is a topic that deals with instrument general knowledge. Questions 
have multiple choice answers. 
 
Question such as  ‘What family of instruments is the Flute in?’ will be asked.

Instrument Range

In Instrument Range, you are asked to identify the keys of various instruments, and identify 
the most ‘common’ key.

Instrument Recognition

In Instrument Recognition, instrument examples are played (WAV files), and you have to 
identify the instrument for a number of choices.

Instrument Transposition

In Instrument Transposition, you will need to be able to transpose to and from concert pitch 
and the correct key for a particular instrument.

Intervals

In Intervals, you will have to identify an intervals that is shown on a staff, or click in a 
interval on a staff.
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Jazz Chords

In Jazz Chords, you will have to identify a chord that is shown on a staff, or click in a chord 
on a staff.

Jazz Chord Symbols

In Jazz Chord Symbols, you will have to identify chord symbols, and the structure of the 
chord that they represent.

Jazz Scales

In Jazz Scales, you may be asked to idenfity a scale shown on screen, fix incorrect notes in 
the scale, or enter the scale on a staff.

Key Signatures

The Key Signatures topic asseses your knowledge of keys, in particular, the number and 
type of accidentals that keys have and the order in which they appear on a staff. Identifying 
relative major and relative minor is also covered.

Meter Recognition

In Meter Recognition, you will have to be able to identify time signatures and their 
characteristics.

Modulation

In Modulation, a two part example is shown that will modulate from one key to the other. 
You will be asked to identify the type of modulation (eg. Major Tonic - Relative Minor) or 
identify the final key of the example.

Note Reading

In Note Reading, you will have to identify notes on a staff, or click in notes on a staff.

Ornaments

In Ornaments, you will have to identify ornaments such as trills, acciaccatura, appoggiature 
etc.

Rhythm Notation

Rhythm Notation tests the knowledge of note and rest values.
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Rhythmic Subdivision

Rhythmic Subdivision tests the knowledge of note and rest values, and the concept of 
subdivision.

Rhythm Tapping

In Rhythm Tapping, an rhythm is shown on screen, and you are asked to tap it back using 
your keyboard.  You may also tap the rhythm in using an external MIDI device such as a 
keyboard or wind controller, if connected.

Scale Home Keys

Scale Home Keys tests the ability to relate a mode to it’s parent major or minor scale.

Scale Degrees

Scale Degrees tests students ability to recognise a key signature and then identify the scale 
degree that a given note is within the key.

Scales

In Scales, you may be asked to idenfity a scale shown on screen, fix incorrect notes in the 
scale, or enter the scale on a staff.

Solfege

In Solfege, you will need to identify the displayed Solfege hand signs.

Symbols

Symbols tests the knowledge of common symbols that are found on scores. Questions are 
multiple choice.

Terms

Terms tests the knowledge of common terms that are found on scores. Questions are 
multiple choice.
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Technical Support

Before contacting Rising Software Technical Support, please consult this User’s Guide and 
the online help.  If you still cannot resolve your problem or query, please contact Rising 
Software Technical Support through one of the methods below.

When contacting Rising Software, please have the following details on hand:

1. The version of Musition you are using;

2. The version of Microsoft Windows you are using;

3. The type of sound or MIDI equipment you are using, and details of your Musition 
sound configuration, if it is a sound related problem;

4. Whether Musition is installed on a network, and if so, what type;

5. What the exact problem is, such as the exact message given by Musition , what you 
were doing when the error occurred (eg practising intervals, reviewing students’ 
statistics, etc), and any other details you feel are relevant.

Internet

Rising Software maintains a web site at the following address: 
 
 http://www.risingsoftware.com.   
 
Consult our site before using alternative forms of communication.  Listing of known bugs 
and program updates will be listed there.

Email

We can be contacted through email on the internet (and associated networks) at the address: 
support@risingsoftware.com.

Fax

You are welcome to fax any correspondence regarding Musition to us on +61 3 9481 3380.  
Please include a fax number if you wish your query to be responded to by fax. 

Telephone

You can reach the Rising Software office during business hours on + 61 3 9481 3320.  If 
you are in the USA, please call (888) 667 7839.  If we are unavailable, please leave a 
message and we will return your call.
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Post

You can reach Rising Software by post at:

Rising Software Australia
3 Darling St
Fairfield, VIC  3078
AUSTRALIA
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License Agreement

WARNING

PERMISSION TO USE THIS SOFTWARE IS CONDITIONAL UPON YOU AGREEING TO THE TERMS SET OUT 
BELOW. BY DOWNLOADING, INSTALLING OR USING ANY COMPONENT OF THE SOFTWARE, OR BY 
REGISTERING THE PRODUCT, YOU (AS AN INDIVIDUAL OR LEGAL ENTITY) AND YOUR EMPLOYEES (IF 
ANY) AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT WHICH WILL GOVERN THE USE OF THE 
PRODUCT.  

IF YOU DO NOT ACCEPT THESE TERMS, DO NOT DOWNLOAD, INSTALL OR OTHERWISE USE ANY 
COMPONENT OF THE SOFTWARE.

IF YOU DO NOT ACCEPT THESE TERMS AND THE SOFTWARE HAS BEEN SUPPLIED IN A SEALED PACKAGE, 
PROVIDED THAT YOU DO NOT OPEN THE SEALED PACKAGE YOU MAY, WITHIN 14 DAYS OF PURCHASE, 
RETURN THE SOFTWARE IN ITS INTACT SEALED PACKAGE TO YOUR SUPPLIER TOGETHER WITH DATED 
PROOF OF PURCHASE FOR A FULL REFUND.

The Product is copyright © Rising Software Australia Proprietary Limited and its licensors 1996 - 2005.

1. Definitions

In this Agreement the following words and expressions have the following meanings:

“Demonstration Software”: components of the Software, containing some but not all of the components of the 
Software which is supplied for evaluation purposes only and is not suitable for commercial or education use.

“Documentation”: the Musition User Guide, Musition Install Guide, on-screen help and any other documentation relating to 
the Software supplied to you in any form by the Licensor or with the Software.

“Firebird Software”: means open source software produced by the FirebirdSQL Foundation (Inc.).

“Intellectual Property Rights”: all and any patents, patent applications, trade marks, service marks, trade names, domain 
names, registered designs, unregistered design rights, copyrights, know how, trade secrets and rights in confidential 
information, URLs and all and any other intellectual property rights, whether registered or unregistered, and including all 
applications and rights to apply for any of the same.

“Interbase Public Licence”: the interbase public licence for Firebird software that is available at http://www.firebirdsql.
org/index.php?op=doc&id=ipl.

 “Licensor”: Rising Software Australia Proprietary Limited, an Australian company (A.C.N. 057 077 213) of 3 Darling St, 
Fairfield, Victoria, 3078, AUSTRALIA.

“Software”: Musition for Windows, Opus and Inkpen2 font families, installers, demonstrations of other software, and any 
other programs or files supplied to you on or with the Musition CD-ROM or download and all modifications, enhancements, 
updates or upgrades to the Software but does not include any Firebird Software.

“Product”: the Software and the Documentation.

“Single Copy”: a Product provided for use on a single computer terminal.

“Single Professional”: a Product provided for use on a single computer terminal.

“Single Academic”: a Product provided for use on a single computer terminal.

“Student Edition”: a Product provided for use on a single computer terminal.

“Multi User License”: a Product provided for use on multiple computers.

“Site License”: a Product provided for use on multiple computers.

“Lab Pack”: a Product provided for use on five (5) computer terminals.

2. License

 2.1 (1) Subject to clause 2.1(2) and clause 2.8 the Licensor grants to you a non-exclusive non-transferable license 
to use the Software in accordance with the Documentation.



46    Rising Software

(2) If you have requested Demonstration Software, the Software licensed under this Agreement is limited to the 
Demonstration Software and the Licensor expressly disclaims any warranty that the Demonstration Software is of 
merchantable quality or fit for any purpose and will not be liable for any damage or loss whatsoever as a result of your use 
or reliance on the Demonstration Software. 

(3) If the Product is a Site License or a Multi User License, you may install the software on the licensed number of 
computer terminals. Any further use if prohibited

(4) If the Product is a Lab Pack, you may install the software on up to five (5) computers, on a single geographical site.

(5) If the Product is not a Lab Pack, Multi User License or Site License, you may install the Software on a single computer.

(6) Title to the Product is not transferred to you.  Ownership of the Product remains vested in the Licensor.  All other rights 
are reserved.

2.2 You may make one printout for your own use of any part of the Documentation provided in electronic form.  
You shall not make or permit any third party to make any further copies of any part of the Product whether in eye or 
machine-readable form.

2.3 You must not, and must not cause or permit any third party to, translate, enhance, modify, alter, adapt or create 
derivative works based on the Product or any part of it for any purpose (including without limitation for the purpose of error 
correction), or cause the whole or any part of the Product to be combined with or incorporated into any other program, file 
or product for any purpose, except as expressly permitted by the Documentation or otherwise in writing by the Licensor..

2.4 You must not, and must not cause or permit any third party to, decompile, decode, disassemble or reverse 
engineer the Software in whole or in part for any purpose.

2.5 You must not, and must not cause any third party to translate, convert, decode or reverse engineer the database 
files in any version, or modify any such file (except by using the Software in accordance with the Documentation), in whole 
or in part for any purpose.

2.6 The Product or any part of it must not be used to infringe any intellectual property right or right of privacy, 
publicity or personality or any other right whatsoever of any other person or entity.

2.7 Use of the Firebird Software that is provided with the Software is subject to the terms and conditions of the  
Interbase Public Licence.

2.8 You acknowledge and agree that: 

(1) you have read, understood and agree to be bound by the terms of the Interbase Public Licence;

(2) you are responsible for ensuring that any employees who have access to the Software are aware of the conditions of the 
Interbase Public Licence.

3. Intellectual Property 

3.1 You acknowledge and agree that all Intellectual Property Rights, including without limitation the copyright  in 
the Product as a whole and in the components of the Product as between you and the Licensor belongs to the Licensor and 
is protected by law.  Further details of the ownership of all copyright in the components of the Product are set out in the 
Product.

3.2 You must not attempt to assert any intellectual property rights over the Product.  You must not remove or alter 
any logo, copyright or other proprietary notices, symbols or labels in the Product.

4. Liability of the Licensor

4.1 You acknowledge that in entering into this Agreement you have not relied in any way on our representations, 
descriptions, illustrations, specifications, skill or judgment and that you have satisfied yourself as to the condition and 
suitability of the Software for your purposes.

4.2 The Licensor does not warrant that the functions contained in the Software will meet your requirements or is 
suitable for your use or any other purpose or that operation of the Software will be uninterrupted or problem or error free. 
The Licensor does not warrant that the Software will function as documented, expected or promised or is of merchantable 
quality. Use of the Software or any part of it is at your sole risk.  You must determine that the Software meets your 
requirements, including compatibility with other computer programs or equipment. 

 4.3 Unless this Agreement expressly provides otherwise, the Licensor gives no condition, warranty, undertaking or 
representation in relation to the condition, accuracy, suitability, quality of or title to the Software and to the extent permitted 
by law, all implied conditions, warranties and liabilities (including liability as to negligence) in relation to same arenegated 
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and excluded. 

4.4 Notwithstanding clause 4.2, the Licensor does warrant that the physical medium upon which the Software is 
provided and the Documentation will be free from defects in materials and workmanship for a period of fourteen (14) days 
after the date of original purchase (the “Warranty Period”).  If a defect in the physical medium or Documentation shall occur 
during the Warranty Period, the Product may be returned with dated proof of purchase to the Licensor who will at its sole 
discretion either return the price paid or repair or replace it free of charge.

4.5 You will indemnify the Licensor and keep the Licensor indemnified against:

(1) all and any demands, claims, actions and proceedings whatsoever and howsoever arising made by any third person 
in connection with or arising out of your use of the Software (except to the extent that they arise due to the fault of the 
Licensor or its employees or agents); and

(2) all and any losses, costs, expenses and damages whatsoever and howsoever incurred by the Licensor in connection with 
or arising out of a breach by you of any provision of this Agreement.

4.6 Nothing in this Agreement excludes, restricts or modifies any condition, warranty, right or remedy which is 
conferred on you by the Trade Practices Act 1974 (Cth) or any other consumer legislation as amended (the “Acts”) which 
we are not lawfully able to exclude, restrict or modify.  Where we breach a non-excludable condition or warranty which has 
been implied by the Acts, our liability for breach will be limited, to the extent lawfully permissible, to:

(1) in the case of supply of goods, the replacement of the goods or the supply of equivalent goods, the repair of the goods, 
the payment of the cost of replacing the goods or of acquiring equivalent goods, or the payment of the cost of having the 
goods repaired;

(2) in the case of the provision of services, the supplying of the services again, or the payment of the cost of having the 
services supplied again;

whichever the Licensor sees fit to provide.

4.7 Notwithstanding anything to the contrary in this Agreement, the Licensor’s entire liability for breach of its 
covenants and warranties in this Agreement and for any defect or errors in the Product shall  be limited to the price paid by 
you for the Product.

4.8 To the extent permitted by law, you acknowledge and agree that the Licensor is not liable for any loss or 
damage, including any special, indirect or consequential loss or damage (including economic loss, loss of profits, business 
interruption, loss of business OR loss of revenue) whether such loss is caused by the Licensor’s breach of its obligations 
under this Agreement or any negligence or other tortious act or omission or  in any way results from your use, non-use or 
inability to use the whole or any part of the Product (including as a result of any malfunction, breakdown, error or virus in 
the Software) or otherwise OCCURS in connection with this Agreement.

5. Termination

 This License shall terminate automatically upon your destruction or if you otherwise lose custody of the 
Product.  In addition, the Licensor may elect to terminate this License in the event of a material breach by you of any 
condition of this Agreement or any of your representations, warranties, covenants or obligations hereunder.  Upon 
notification of such termination by the Licensor you will immediately delete all copies of the Software from your 
computer(s), destroy any other copies of the Product or any part thereof, or return the Product to the Licensor.

6. Miscellaneous

6.1 No failure to exercise and no delay in exercising on the part of the Licensor of any right, power or 
privilege arising hereunder shall operate as a waiver thereof, nor shall any single or partial exercise of any right, 
power or privilege preclude any other or further exercise thereof or the exercise of any other right, power or 
provilege.  The rights and remedies of the Licensor in connection herewith are not exclusive of any rights or remedies 
provided by law.

6.2 You may not distribute, loan, sub-license, rent, assign, lease (including without limitation renting or 
leasing a computer on which the Product is installed) or otherwise transfer the Product to any third party without 
the Licensor’s prior written consent, which the Licensor may grant, condition or withhold in the Licensor’s sole 
discretion.

6.3 You agree to the collection and use of your personal data in accordance with the Licensor’s privacy 
statement (available from the Licensor or at the Licensor’s website at http://www.risingsoftware.com/privacy.shtml) 
which may change from time to time.

6.4 This Agreement is intended by the parties hereto to be a final expression of their agreement with respect 
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to the subject matter hereof and a complete and exclusive statement of the terms of such agreement.  This Agreement 
supersedes any and all prior understandings, whether written or oral, between you and the Licensor relating to the 
subject matter hereof.

6.5 This Agreement shall be construed and governed by the laws of Victoria, Australia and both parties 
agree to submit to the exclusive jurisdiction of the Victorian courts.

6.6 The provisions of this Agreement shall not be varied, except by agreement in writing and signed by the 
parties.

6.7 If there is a disagreement between you and the Licensor that cannot be resolved then prior to 
commencing proceedings in any Court, you must refer the matter to the Australian Commercial Disputes Centre for 
arbitration in accordance with the Centre Guidelines on Arbitration.  The decision of the arbitrator (including any 
award as to costs) will be final and binding.
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